MLA FORMAT:
Check and/or set the following BEFORE you begin typing your paper:

✨ Note: The following directions are for Microsoft Word 2007 and newer.

◆ Margins - All margins should be one inch.
  • Go to the toolbar at the top of the screen. Click the Page Layout tab. Click the Margins icon. Click Normal with top, bottom, left, and right all saying 1”.

◆ Line Spacing - All text should be double-spaced. Do not put extra spaces below the title or between paragraphs.
  • Go to the toolbar at the top of the screen. Click the Home tab. In the Paragraph section of the Home tab, click the tab with the Up and Down Arrows and lines. A menu will drop down. Click 2.0

◆ Justification - Justification refers to the alignment of the text. All text should be left-aligned, except the title (center-aligned) and the page numbers (right-aligned). The alignment buttons are located in the paragraph section of the Home tab.

◆ Pagination - Put your last name and the page number in the upper-right corner of every page (including the first page).
  • Go to the toolbar at the top of the screen. Click the Insert tab. Click the Page Number icon. Select Top of Page. Then select the third option, Plain Number 3.
  • The page number should be displayed in the header. Press the spacebar once, and then type your last name.
  • Click the Close Header and Footer icon on the right side of the design tab in the toolbar.

◆ Name and Title - Unless your professor specifically requires a title page, you do not need it. Instead of making a title page,
  • Type your name, your professor’s name, the course title, and the date at the top left corner of your paper.
  • Below the date, center the title of your paper.
  • Below the title, begin your 1st paragraph (left aligned). Remember to indent the first line of each paragraph one-half inch

Saving Your Work:
Make sure to save your work often on a portable hard drive/flash drive.
The Communications Lab computers support Office XP, Office Vista, Office 2010, and Open Office.
The Influence of Reggae in Punk Rock Music

The decade of the 1970’s was a melting pot for various tastes in international music. Disco reigned as the superficial feel-good music while punk rock and reggae emerged on the scene with a political fervor which challenged societal norms. Though quite different on the surface, punk and reggae share a common spine: the backbone of the baseline and its anarchical nerve.
CREATING IN-TEXT CITATIONS
(also known as parenthetical citations)

A “citation” is a method of giving credit to the originator of a source. To correspond with a works cited page, you must also make shortened citations within the body of your paper. Cite everything that is directly quoted AND everything that is paraphrased. You paraphrase when you take ideas from a source and put them into your own words. Every piece of information that is not your own idea and/or not considered common knowledge should be cited. Note the punctuation in the following examples.

Notes:
✦ The first word of the in-text citation should match the first word of the works cited entry to which it corresponds. For example, if the works cited entry begins with the author’s last name, then use the author’s last name for your in-text citation. If the works cited entry begins with the title of a work, then use the same title for your in-text citation. If the title of the work is long, use the first meaningful words of the title (usually the first three words of the title).
✦ If you use the author’s name (or any other citation information) in the sentence, you do not need to include it in the in-text citation.

For example:
Correct: According to Fisher, “All dogs do go to heaven” (175).
Correct: “All dogs do go to heaven” (Fisher 175).
Incorrect: According to Fisher, “All dogs do go to heaven” (Fisher 175).

Basic format:
List the last name of the author (or editor or translator) and the page number.
“Janie’s life flashed before her eyes, but it wasn’t the life she remembered” (Weaver 56).

No author:
List a shortened title or the full title (if short) and the page number.
✦ If the title is in italics in the works cited entry, use italics in the in-text citation. If it has quotation marks around it, put quotation marks around it in the in-text citation.
“Due to its large number of lakes, Oklahoma has a high population of water fowl” (“Nature” 68).

Poetry:
When citing poetry, use the line numbers instead of the page number. Place slashes between the lines. Preserve all the punctuation and capitalization of the original lines as they appear in the source.
“Well, I like to eat, sleep, drink, and be in love. /I like to work, read, learn, and understand life.” (Hughes 21-22).

No page number:
List the last name of the author, editor, or translator
OR if there is no author, just use the title
“The guerillas, whose original purpose was to fight the government for the people’s sake, eventually became more corrupt than the government” (Cortazar).
Sacred Texts or Anonymous Books:

List the title of the text, an abbreviated or full title of the book or section, the chapter number (if applicable), and the verse number (if applicable).

Example: (2 Cor. 5.17)

- A period separates chapter and verse.
- The first time you refer to a particular version of the Bible, include the name of the version, followed by a comma.
  Example: (New International Version, Gen. 3.15)
- You do not need to identify the version in subsequent references unless you switch to a different version.

Two or more works:

If you want to cite more than one work in the same in-text citation, use semicolons to separate them.
(Gray 78; “Heavens” 59-61; Shooting Stars)

Block quotes:

For more than three lines of poetry or more than four lines of prose, press Enter and begin the quote on a new line. Press Tab twice to set this quote off 1 inch from the body of the paper. Double space your entry. Block quotes do not need quotation marks, but they do need to include a parenthetical citation at the end. End punctuation for a block quote needs to go at the end of the line, not after the parenthesis. See the example below:

I wonder if it’s that simple?

I am twenty-two, colored, born in Winston-Salem.

I went to school there then Durham, then here.

to this college on the hill above Harlem. (Hughes 6-10)

Indirect source:

Sometimes it is necessary to quote something that your source has already quoted. To do this, use the abbreviation qtd.in (i.e. quoted in), so the citation will look like this:
(qtd. in Johnson 23).
CREATING THE WORKS CITED PAGE

**Notes:**

- List the entries in alphabetical order.
- For the purpose of saving paper, the entries in this handout are single-spaced. **You should double-space your entries, but do not put extra spaces between entries.**
- If no author is given, begin with the title of the work. Then alphabetize by the first meaningful word of the title (not by A, An, The, etc.)
- Remember to punctuate your entry exactly like the example including hanging indentations for every second and third line.
- If you want to see exactly what a works cited page should look like, see the model on page eleven of this handout.

**BOOKS**

**Basic format:**

1.) Author’s name, editor, compiler, or translator  
2.) Title of the book in Italics  
3.) Edition used (if applicable)  
4.) Number(s) of the volume(s) used (if applicable)  
5.) City of publication, name of the publisher, and year of publication  
6.) Medium of publication consulted (Print)

Author, last name first. Title of Book. Place of publication: Publisher, date of publication. Medium.

**Book by a Single Author:**

**Two or More Books by the Same Author:**
- For every entry after the first, use three hyphens to represent the author’s name, followed by a period and then the title.

**Book by Two or More Authors:**
- Give the authors’ names as they appear on the title page. Reverse the name of the first author only and follow it with a comma. The subsequent authors’ names will be in normal form.
**Story, Poem or Other Work in an Anthology or Compilation (such as a textbook):**
Author of story, last name first. “Title of Story, Poem, or Other Work.” *Title of Anthology or Compilation.* Edition. Editor’s Name. Place of Publication: Publisher, date of publication. page numbers. Print.


**Encyclopedia or Dictionary:**
1.) Author of selection (if applicable)
2.) Selection in quotation marks
3.) Title of encyclopedia or dictionary in italics
4.) Edition
5.) Year of publication
6.) Medium of publication consulted (Print)


**Anonymous Book:**

**Translation:**

**Pamphlet:**

**Government Publication:**

**Sacred Text or Anonymous Book (such as the Bible or Qur’an):**
*Note:* ✤ Save the book, chapter, and verse number for the in-text citation. Do not put it in the works cited entry.

1.) Title of a specific edition should be in italics; however, if a specific edition is not mentioned in the title, do not place it in italics. Note examples below.
2.) Editor or translator (if there is one) but list an author first if there is one for the work
3.) Edition (if applicable)
4.) Publication place
5.) Publisher
6.) Date of publication
7.) Medium of publication (Print)


PERIODICALS (articles in scholarly journals, newspapers, and magazines):

Article in a Journal With Pages Numbered by Issue (Each issue begins with page 1, so you must list both the volume and the issue number to indicate where the article can be found. After the journal title, list the volume number first, then a period, then the issue number.): 
Author, last name first. “Article Title.” Journal Title Volume number. Issue number (year of publication): page numbers. Medium consulted.

Article in a Journal With Pages Numbered by Volume (Instead of starting page numbers over with each issue, some journals number pages continuously throughout the year, and then bind them into a collective volume at the end of each year. Therefore, there is no need to list the issue number.): 
Author, last name first. “Article Title.” Journal Title Volume number (year of publication): page numbers. Print.

Journal Abstract (formal summary of an article):

Newspaper Article:
1.) Author’s name (if there is one)
2.) Article title
3.) Newspaper title
4.) Date
5.) Page number
6.) Medium consulted (Print)
Author, last name first. “Article Title.” Newspaper Title date: page number. Medium consulted.

Magazine Article:
1.) Author’s name
2.) Article title, in quotation marks
3.) Magazine title, underlined
4.) Date and page numbers (remember to put a colon : between them)
5.) Medium consulted (Print)
Author, last name first. “Article Title.” Magazine Title date: page numbers. Medium.
MISCELLANEOUS SOURCES:

Television or Radio Program:
Note: ★ Other information you may wish to include (director, performers, narrator) may be included after the title of the episode, program, or series – wherever it seems most applicable.
1.) Episode title (if applicable), in quotation marks
2.) Program title in italics
3.) Network name (if any)
4.) Call letters and city of local station (if applicable)
5.) Broadcast date
6.) Medium of reception (Radio or Television)

The Origins of Jazz. PBS. OETA, Oklahoma City. 18 June 1996. Television.

Sound Recording:
1.) Artist(s)
2.) Song title, in quotation marks
3.) Album or recording title in italics
4.) Manufacturer
5.) Year of issue (or n.d. if unknown)
6.) Medium of publication

Note: If you are citing a specific song, place its title in quotation marks.

Film or Video Recording:
1.) Title in italics
2.) Director
3.) Other information you may wish to include (names of performers, writer, producer)
4.) Distributor
5.) Year of release
6.) Medium (Film)


Performance (concert, play, ballet, opera):
1.) Title in italics
2.) Director
3.) Other information you may wish to include (names of performers, writer, producer)
4.) Theater
5.) City
6.) Date of performance
7.) Medium (Performance)

Musical Composition:
Treat a musical score like a book.
1.) Composer’s name, last name first
2.) Title in italics
3.) Date it was written (if applicable)
4.) City of publication
5.) Publisher
6.) Date
7.) Medium consulted (Print)

Painting, Photograph, or Sculpture:
1.) Artist’s name, last name first
2.) Title in italics
3.) Date it was created (if applicable)
4.) Place that houses the piece (museum, gallery, church) or for work in a private collection (Collection of . . .)
5.) City

Interview (3 types - the first name mentioned is always the person who was interviewed):

1.) Published or Recorded Interview:

2.) Broadcast on Television or Radio:

3.) Personal (someone you interviewed):
Minchu, Elena. Personal interview. 7 Apr. 1999.
Reed, Jim. Telephone interview. 10 Dec. 2007.

Lecture, Speech, Address, or Meeting:

Legal Source:
ELECTRONIC PUBLICATIONS:

Notes:
♦ Students often find it difficult to cite Web sites. Keep in mind that many Web sites do not contain all of the information in the following lists. However, much of the information can often be found if you know where to look. Additionally, while aiming for comprehensiveness, writers must often settle for citing whatever information is available to them. MLA style is flexible, and sometimes you must improvise to record features not anticipated by this manual. Please consult your professor for further questions regarding Web sites.
♦ List available information in the order shown in the following lists. Simply skip over items which do not apply. Each item is followed by a period except the publisher or sponsor, which is followed by a comma.

Whole Web Site or Short Work or Document Within a Web site (article, story, poem, etc.):
1.) Author’s name
2.) Title of document or short work in quotation marks
3.) Title of Web site in italics
4.) Editor’s name, if applicable
5.) Name of organization or institution that sponsors the site (unless it is the same as the author or title of the site) followed by a comma; if not available may use N.p.
6.) Date of publication or update; if not available may use n.d.
7.) Medium of Publication (Web)
8.) Date of Access (day, month, and year)

Whole Website:
Author, last name first. Title of Web Site. Sponsoring Organization, Date of publication or update. Web. Date you accessed the site.

Short Work on a Website:
Author, last name first. “Title of Short Work.” Title of Web Site. Editor’s name. Sponsoring Organization, Date of publication or update. Web. Date you accessed the site.

Citing an Online Video:
The MLA does not specifically address how to cite a YouTube or Vimeo video. This has, it appears, led to some confusion as to the best method of for citing YouTube videos in MLA. Based on MLA standards for other media formats, we feel that the following format is the most acceptable for citing YouTube videos:

A periodical publication in an Online Database:
Note:
* Figure out what type of work you have retrieved (i.e. newspaper, journal, or magazine article; poem, play, or short story, etc.) and cite it accordingly. Then follow the steps listed below. Please note, a periodical article on the Web may not include page numbers. If possible, give the inclusive page numbers or, when pagination is not continuous, the first page number and a plus sign; if pagination is not available, use n.pag.
1.) Publication information for the article or other work.
2.) Title of database italicized
3.) Medium of publication (Web)
4.) Date of access (day, month, and year)

Magazine Article Retrieved From EBSCOhost:

Newspaper Article Retrieved From ProQuest:

Journal Article Retrieved From InfoTrac:


Magazine Article Retrieved From Opposing Viewpoints:
Works Cited


Isaak, Brandon. Personal interview. 7 Apr. 1999.


